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A Growing 
Outsourcing Industry 
By Elsie Lee 

This year marks the 
fifth anniversary of 
ELIX Virtual Management 
in the Virtual Assisting 
industry.  

The founding of ELIX was based on the 
concept of Virtual Assistance (VA) – an 
emerging industry created with the 
advent of the Internet and the growing 
trend in business process outsourcing 
(BPO).  

The workplace is no longer confined to 
the premises in a commercial building. 
Telecommuting enables the shift of 
‘bricks and mortar’ workplaces to the 
cyberspace – the virtual workplace. This 
has given rise to the growth of 
entrepreneurships in all forms and at the 
same time, revolutionizes the work 
processes of traditional industries.  

Among many of these entrepreneurs are 
professionals from various industries 
and senior executives with extensive 
corporate work experience. Some of 
them have started their own independent 
consultancy practices from their homes 
or small offices – small office home 
office (SOHOs) – to save on startup and 
operating costs.  

VA = Outsourcing?  
When we talk about outsourcing, most 
people would think of the IT industry, 
as it is one of the earliest to embrace it. 
However, outsourcing is not limited to 
IT processes and large companies. 

Small businesses and SOHOs can also 
outsource many of their non-core 
functions such as admin, accounting, 
contact and database management, 
translation, management support and ad 
hoc projects to independent virtual 
service providers by any name – virtual 
assistants or professionals, freelancers, 
or free agents.  

Depending on the type of services 
required, many virtual assistants are 
able to provide general or specialized 
services at a contracted fee – a variable 
cost to the client. SOHOs can now tap 
on the services of a VA as an outsource 
partner for management support 
services. 

The VA industry is a global industry – 
many cross-border work relationships 
have taken place to take advantage of 
the time-zone difference between 
regions. Clients in the US or UK can 
expect to gain at least 8 to 12 hours in 
turnaround time for a project done by a 
VA in Singapore.    

 
SSSpppeeeccciiiaaalll   CCCooommmmmmeeemmmooorrraaatttiiivvveee   IIIssssssuuueee   

EEELLLIIIXXX   NNNeeewwwsssllleeetttttteeerrr   
 

“Our clients include global top 
50 multinationals and we cannot 
afford to compromise. ELIX 
never fails to deliver. Whether it 
is a brochure, a presentation or 
a 100-page report, ELIX has 
always met our deadlines and 
delivered first-class product.” 

– Steve Puckett 
Managing Director 

TRI-ZEN International 
www.tri-zen.com 

 

Continued on page 2 
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Facts & Figures 
The Internet Statistics: World Internet Usage 
In 1995, there were 25 million Internet users. By year 2000, there were 358 
million users and the latest figure as of 30 April 2004 is 757.5 million.  

Asia – 236 million users 
South Korea has the highest percentage of population (penetration) rate of 62% 
followed by Hong Kong – 61.8% and Singapore – 60%. 

China ends 2003 with nearly 80 million Internet users – a dramatic jump from 
the 620,000 users recorded in 1997. Source: China Internet Network Information 
Center (CNNIC) – www.cnnic.net.cn 

North America – 226 million users 
N. America has the highest penetration rate of 69.3% (by region)  

Source: Internet World Stats (www.internetworldstats.com) 

 

Any business that is looking to go 
international will have the advantage of 
gaining ground knowledge through a 
virtual service provider, located in or 
close to the target country.   

The translation industry – one of the 
oldest professions in the world 
dominated by freelance translators 
scattered across countries has benefited 
greatly by embracing the virtual work 
concept. This is a natural progression 
from the traditional work method via 
faxes, phone or courier services.   

Marketing and translation agencies are 
examples of companies taking 
advantage of the global services 
provided by translators and linguists to 
conduct surveys for their research on 
global acceptance of brand names via 
online surveys.  

Another traditional industry that has 
adopted the virtual business concept is 

the desktop publishing and printing 
industry. More and more industries are 
tapping on the Internet to revolutionize 
their business processes for greater 
efficiencies and cost-effectiveness. 

Thus, we may conclude that 
globalization and the Internet are not 
mutually exclusive. Without one 
another, neither has the potential to reap 
benefits for the world economy. ± 

Doing it right from 
start 
By Elsie Lee 

Assisting startups and small business 
owners write their business plans is one 
of my core services. Many startups and 
small business owners do not see the 
need for a business plan until they are 
seeking funding.  

In the course of my work over the past 
few years, I have come across many 
business owners who found themselves 
in a dilemma when they need to get 
their financial reports into their business 
plans done up for scrutiny by  
prospective investors or banks. What is 
their common problem? 

Most of them have been in business for 
about one to three years and are now 
planning to expand their business by 
seeking new investors or financing from 
banks.  

Proper accounting 
Their common problem is the inability 
to keep proper books of accounts for 
their business. They either under-
estimated their profits or showed no 
profits at all, even though the business 
had generated good income.   

Improper accounting will put the 
business in a difficult position, as 
investors will not invest in a business 
that is not viable or shows no potential 
of making money through past 
performance.  

On the other hand, banks need the 
assurance that the business in concern is 
capable of repaying the loan by a future 
stream of income generated by the 
business. Therefore, a healthy financial 
report for past performance is critical to 
the success of securing a loan by an 
existing business. 

Keep your books clean 
In order to secure grants or subsidies 
from the government, all transactions 
must be properly accounted. Legal 
obligations should be strictly observed 
to ensure that any misdoing would not 
cripple the business. 

Get help from a professional 
Besides keeping proper books of 
accounts, effective cash flow 
management is also vital to the survival 
of a business. If you do not have an 

Continued on page 3 
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accounting background, it is imperative 
that you engage the services of a 
professional bookkeeper or accountant 
to manage your accounts. You will be 
glad you did. ±  

What lies behind the 
facade of a website? 
By Elsie Lee 

Having a corporate website is no longer 
the prerogative of a dotcom or online 
merchants. Companies that do not 
engage in online transactions are also 
finding it necessary to have an online 
presence for many reasons. 

An interesting aspect of the World 
Wide Web is that all companies 

compete on equal ground. For the small 
businesses, the Internet provides a 
growing market for their products and 
services. Having a web presence is a 
cost effective method to reach a global 
market place. It is a lot cheaper and 
faster than direct mail and phone calls. 
Order-taking and customer service are 
also more efficient and cheaper.     

I believe most of us are well aware of 
all the aforementioned. The purpose of 
this article is to highlight a few 
important points to readers who are not 
yet familiar with the technicalities lying 
behind the facade of a cool looking 
website.   

You may have had a web presence for 
years now but it is not bringing you new 
customers or any leads. Have you ever 
wondered why?  

Apart from effective contents, did you 
know that page titles are crucial for the 
search engines? Make sure that your 
website contains the meta tags for the 
page titles, site description and 
keywords. Your page title and site 
description should show up in the title 
bar at the top of your browser (next to 
the IE icon).   

You can do a check on your website by 
viewing the source codes – in your 
browser, click on the View menu for the 
Source. Within the <head> and </head> 
tags, the following should appear: 

<title>your page title</title> 
<meta name= "description" 
content="your site description"> 
<meta name= “keywords” content=  
“keyword1, keyword2, keyword3, etc”> 

Q & A 
Q:   What is a favicon? 

A:   Favicon (pronounced fav-eye-
con) is short for 'Favorites Icon'. 
You can customize the Icon(s) in 
the browsers 'address box window' 
and 'bookmark listing'. Hence, 
when people look at their browsers 
bookmarks they will be drawn to 
your web page because of the 
beautiful logo next to your 
bookmark. When they view your 
web site, they can confirm that 
they are viewing your website by 
seeing your customized icon(s) in 
the browser 'address box window'. 

http://www.favicon.co.uk/ provides 
a FREE On-Line Icon Generator 
that you can use to generate Icons 
for your website.  

Example:  

 http://www.elix.com.sg 

 

. 

. 

. 

. 

UUsseeffuull  LLiinnkkss  
World Resources Institute 
www.wri.org/wri 

World Resources Institute is an 
independent nonprofit organization 
with a staff of more than 100 
scientists, economists, policy 
experts, business analysts, 
statistical analysts, mapmakers, 
and communicators working to 
protect the Earth and improve 
people's lives. 

SingStat Express 
www.singstat.gov.sg 

If you need data on a regular basis 
and find it a hassle to remember 
release dates, subscribe to 
SingStat Express now and you will 
receive the data as soon as they 
are released.  The service will also 
notify you on publication releases 
which might be of interest to you.    

 
Future of Work 
www.dol.govt.nz/futureofwork 

The site provides info on the 
changing economy, the changing 
workplace, the changing 
workforce, work/life balance, skills, 
education and training. 

International Labour 
Organization  
www.ilo.org 

The site features reports on global 
employment trends, statistics, 
training and skills development 
programmes for the labour force.   

 
 

 

 

Continued on page 4 
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Wired Media Pte Ltd 
Singapore – www.wm.tm 
 
Connecting business online 
A One-Stop solutions provider 
for web applications backed by 
state-of-the-art network 
infrastructure…For more 
information, call 65-6348-8783 
or email info@wm.tm 

 
 
 
 
 
 
 

 

Continued from page 3 

Search engines may not be able to 
properly spider a framed site. Using 
frames either prevents them from 
finding pages within a web site, or it 
causes them to send visitors into a site 
without the proper frame "context" 
being established, in particular, if you 
have your company logo kept in one 
frame that is constantly visible.  

Therefore, if a visitor comes into the 
website from a search engine link, the 
webpage may be on its own without the 
‘header’ where your company logo and 
key information might appear.  

Bookmarking a framed page within a 
website generally would not work, and 
typically, only the main page of the 
website can be bookmarked. For more 
information about frames, read this 
article, “Search Engines and frames” by 
Danny Sullivan of Search Engine Watch 
[see link box below page] and 
http://www.htmlhelp.com/design/frames 

Flash may look cool on a site but not 
everyone has the plug-in installed. 
Moreover, bear in mind that there are 

still a large number of people in less 
developed countries using a 56K dialup 
modem to access the Internet. Make 
sure you have an alternative no-flash 
option. Even if their browsers have the 
plug-in for flash, in most instances, 
people would skip the flash animations 
by clicking on the skip flash option to 
save time on browsing, particularly the 
time-conscious business visitors.  

Another important detail that should not 
be overlooked is the insertion of 
meaningful alternate text for images. 
Many partially sighted or visually 
impaired rely on the ALT tags on your 
images to find their way around. If you 
use a big image file for the front page of 
your site with no alternate text, then the 
likelihood of your site being listed by 
search engines is very low. 

If you outsource your web design job, 
make sure that your designer observes 
these basic rules or details. In the course 
of my work—rewriting web contents for 
clients—I have come across many sites 
that were not listed by the search 
engines due to the lack of important 
details such as meta tags, framed sites 
or flash on home pages that did not 
contain enough description of the sites.  

Besides good designing skills, it is 
important that your site designer have 
the basic knowledge of how search 
engines work and what design works 
best for your business. 

One common mistake in selecting a 
proposed web design is to go for the 
lowest priced and the aesthetics, often 
overlooking the three basic selection 
criteria for a good website, which are 
accessibility, usability and functionality.  
± 
 

 

 

  

Are you blogging? 
What is a blog? 

Derived from the term “weblog”, a blog 
is a journal that is available on the web, 
a diary style site in which the author 
links to other web pages he or she finds 
interesting.  

The activity of updating a blog is 
“blogging” and someone who keeps a 
blog is a “blogger”. Postings on a blog 
are usually arranged in reverse 
chronological order. 

The term “weblog” was coined by Jorn 
Barger in December 1997. The shorter 
version, ‘blog’ was coined by Peter 
Merholz in April or May of 1999. This 
was interpreted as a short form of the 
noun and as a verb, to blog, meaning ‘to 
edit one's weblog or a post to one's 
weblog’.  

Usage spread during 1999 and the word 
was popularized by Pyra's creation of 
their weblog service Blogger (now 
acquired by Google). The Oxford 
English Dictionary has considered 
including it in their dictionary. 

Creating and publishing weblogs  

Since their introduction, a number of 
software packages have appeared to 
allow people to create their own 
weblog. Blog hosting sites and Web 
services to provide editing via the Web 
have proliferated.  

The various types of weblogs are 
personal, topical, collaborative, political 
and directory. Many businesses have 
started using blogs for both internal and 
external communications with their 
customers. For more information about 
weblogs, visit www.wikipedia.org± 

Source: Wikipedia  
http://en.wikipedia.org/wiki/Weblog#History 
 
Want to create a blog? 
Get one at www.blogger.com free! 

 

[http://searchenginewatch.com/webmasters/article.php/2167901] 
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CREATE A TASK 
A task is a personal or work-related 
errand you want to track through 
completion. A task can occur once or 
repeatedly (a recurring task). To 
create a task from scratch: 

1. On the File menu, point to New, 
and then click Task.  

2. In the Subject box, type a task 
name.  

3. Complete any other boxes on the 
Task and Details tabs for information 
you want to record for the task. For 
help on an option, on the Help menu, 
click What's This, and then click the 
option.  

4. To make the task recur, click 
Recurrence, click the frequency 
(Daily, Weekly, Monthly, Yearly) at 
which you want the task to recur, and 
then do one of the following:  

* Make the task recur at regular 
intervals 

Select options for that frequency. Do 
not click Regenerate new task, or 
the task will not recur at regular 
intervals. 

* Make the task recur based on 
completion date 

Click Regenerate new task, and 
then type a time frequency in the box. 

5. If you want, set start and end dates 
for the task.  

6. Click OK, and then click Save and 
Close. 

 

NAVIGATING FOLDER LIST IN OUTLOOK 
The folder list (navigation pane) 
makes it easy to move around 
between mail folders and to drag and 
drop messages from one folder to 
another. If you have many nestled 
folders, it is usually impossible to 
view all your folders at once in the 
list.  

Instead of clicking your way down 
through the folder tree, use the 
keyboard for quick access: 

1. Press Ctrl+Y to open the Go To 
Folder dialog.  

 

 

 

 

 

 

2. Navigate quickly by pressing the 
first character of a folder's name; 
press the same character repeatedly 
to cycle through folders that begin 
with the same letter.  

* Use the right-arrow key or + key on 
the numeric keypad to expand 
collapsed parts of the folder tree 
(those preceded by a + sign);  

* Use the left-arrow key or - key on 
the numeric keypad to collapse 
expanded branches;  

* Use the up and down arrow keys to 
move up and down, the Home key to 
move to the top of the list, the End 
key to move to the bottom, and the 

PgUp and PgDn keys to move by 
intermediate jumps. 

3. Hit Enter to open the highlighted 
folder.   

PRINT A CALENDAR FROM OUTLOOK   
1. Select Calendar in the Folder 

List. 

2. On the File menu, click Print 
and then in the Print style box, 
click the print style you want.  

3. To print the details of 
appointments and meetings, in 
the Print Style box, click 
Calendar Details Style. 

4. In the Start list and the End list, 
enter the first day and the last 
day to print.  

5. To set other print options, such 
as the paper orientation or the 
fonts used, click Page Setup, 
and then select the options that 
you want.  

 
 
 
 
 
 
CREATE A MEETING REQUEST FROM A 

CONTACT  
1. In Contacts, click the contact, 

and then on the Actions menu, 
click New Meeting Request to 
Contact.  

2. In the Subject box, type a 
description.  

3. In the Location box, enter the 
location.  

4. Enter start and end times.  
5. Select any other options you 

want.  
6. Click Send 

Tech Tips 
MS Outlook – more than just an email program 
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Organized by Internauts Association 
and Panda Software, the aim of the  
1st Worldwide Internet Security 
Campaign is to make the Internet a 
safer place for all users. 

The campaign is available at 
http://www.worldwidesecure.org and 
in the eight most widely spoken 
languages, covering 86.4% of 
Internet users. 

The 1st Worldwide Internet Security 
Campaign has been set up with clear 
objectives.  

*The first is to create a more secure 
Internet for all users.  

*The second objective is to make 
users more aware of the basic 
preventive security measures that 
they can take to help keep their 
computers free from viruses and 
intruders.   

Finally, the campaign aims to 
provide access to content, tools and 
free applications, designed to keep 
computers free from the effects of 
viruses or any other type of intruder. 
Internet users can access the 
information, training and solutions 
they need to protect their PCs against 
Internet threats until July 31 on the       
campaign site. 

. 

. 

. 

. 

MMiilleessttoonneess  
Sep 1999 
Conceptualization 
Research and study into the 
feasibility and benefits of Virtual 
Assisting concept. 

Nov 1999 
Founding of ELIX 
ELIX Virtual Management was set 
up to provide business support 
services through virtual assistance. 

Feb 2000 
Launch of website 
www.elix.com.sg was launched 

Feb 2000 
Publication of article 
Today’s Manager 
First article on VA published in 
Today’s Manager (Feb/Mar Issue) 

May 2000 
Publication of article  
The Straits Times, Recruit 
Section 
Second article on VA published in 
The Straits Times over two days 
(May 1 & 2) in two parts. 

Aug 2000 
‘Above & Beyond’  
Staffcentrix Citizenship Award 
Received the Staffcentrix ‘Above & 
Beyond’ award for exceptional 
contributions to the Staffcentrix 
community. 

Sep 2003 
Host of ‘Expert of the Month’ 
Session at IVAA 
Hosted ‘EOM’ sessions on 
Business Planning for members of 
International Virtual Assistants 
Association (IVAA).  

  

About the firm 
ELIX Virtual Management – a 
Technopreneur Home Office 
endorsed by EDB, Singapore – 
provides business support services 
through virtual assistance. The firm 
is owned and operated by an 
independent professional service 
provider, Elsie Lee who specializes 
in: 

• Business writing and editing – 
business plans, company 
profiles, web contents, sales 
literature, etc 

• Translation (English/Chinese) – 
company profiles, web contents, 
marketing collaterals, etc    

• PowerPoint presentations – 
keynote speeches, company & 
sales presentations, workshops, 
survey results, etc 

• Financial projections – for 
business plans – cash flow, 
income, sales, balance sheets, 
startup budget, operating 
expenses 

• Research & Survey assistance – 
design questionnaire, collate & 
sort data collected, presentation 
of survey results, internet 
research 

N
ews 

 

If you have any 
comments or feedback, 
please send to 
info@elix.com.sg 

“Thank you for always providing 
reliable and high-quality 
services. We enjoy working with 
you very much. Congratulations 
on your 5th Anniversary!” 

– I-Chin Lin 
Translating Services 

Coordinator 
Choice Translating, Inc. 

www.choicetranslating.com 
 

 


